
Keyboard shortcuts 
Which keys do you want to use? 

Keys for working in a spreadsheet 
Keys for moving and scrolling in a worksheet or workbook 

Keys for previewing and printing a document 

Keys for working with worksheets, charts, and macros 

Keys for working with data 
Keys for entering data 

Keys for formatting data 

Keys for editing data 

Keys for selecting data and cells 

Keys for selecting charts and chart items 

Keys to use with databases and lists 

Keys for outlining data 

Keys to use with PivotTable and PivotChart reports 

Keys to use with the OLAP Cube Wizard 

Keys for working in Microsoft Office 
Keys for menus and toolbars 

Keys for windows, dialog boxes, and edit boxes 

Keys for the Office Assistant 

Keys for working with the Open and Save As dialog boxes 

Keys for sending e-mail messagesl 

Keys for working with drawing objects, AutoShapes, WordArt, and other objects 
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Print a list of shortcut keys 
1. If the Contents tab isn't visible, press ALT+C to display it. 

 
2. Select the heading Shortcut Keys, press ALT+O, and then press P.  

 
3. Click Print the selected heading and all subtopics. 

 
4. Select the printing options you want.  

 

Accessibility for people with disabilities 
Microsoft Excel contains features that make it easier for people who are blind or have low vision to read 
and for those with limited dexterity to write. Learn about using accessibility features. 

What do you want to do? 
Change the magnification and color of text 

Customize toolbars and menus 

Use keyboard shortcuts 

Automate entering and editing text and data 

Change the magnification and color of text 
Magnify or reduce the screen display 

Make toolbar buttons larger 

Scroll and zoom on a Microsoft Excel sheet by using the Microsoft IntelliMouse pointing device 

Change the color palette used in a workbook 

Change the font and colors for Help topics 

Customize toolbars and menus 
Create a toolbar 

Group related buttons and menus on a toolbar
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Add a button to a toolbar 

Add a command to a menu 

Use keyboard shortcuts 
Use shortcut keys 

Print a list of shortcut keys 

Automate entering and editing text and data 
Correct spelling and typing errors as you type 

Quickly fill in repeated entries in a column 

 

About accessibility for people with disabilities 
Change the magnification and color of text 
You can change the magnification of your spreadsheet to make information easier to read on the screen. 
You can also make toolbar buttons larger so they're easier to see and use. If you use the Microsoft 
IntelliMouse pointing device, you can scroll and zoom directly from the mouse instead of clicking 
buttons on the screen. For example, you can automatically scroll to the end of the document with just 
one mouse click. You can also create a custom color palette so that only colors you define are used. 

In Help topics, you can change the font and colors. 

Customize toolbars and menus 
If you use only a subset of toolbar buttons and commands, you can create a toolbar that contains only 
those buttons and menus you use most often. You can also group toolbar buttons and menu commands 
together in a way that makes the most sense to you. 

Use keyboard shortcuts 
Many features and commands are available directly from the keyboard. You can also view and print lists 
of all available shortcut keys. 

Automate entering and editing text and data 
Microsoft Excel can correct common spelling and typing errors as you work and, when you type a few 
identifying characters, can automatically complete recurring entries within a column. 

Page 3 of 30Keyboard shortcuts

2/22/2006file://C:\Documents and Settings\mo_luscre\Local Settings\Temp\~hh6D44.htm



Customize the operating system 
You can set or change system accessibility options. For example, with the Windows MouseKeys feature, 
you can use the numeric keypad to move the pointer and to click, double-click, and drag. On the 
Windows Start menu, point to Settings, and then click Control Panel. Double-click Accessibility 
Options, click the tab you want, and then select the options you want. For Help on an option, select the 
option, and then press SHIFT+F1. 

More information 
More complete information about Microsoft services for people with disabilities is available in an 
appendix in Discovering Microsoft Office 2000. For example, you'll find information about how people 
who are deaf or hard-of-hearing can contact the Microsoft Sales and Information Center or Microsoft 
Support Network. You'll also find information about obtaining Microsoft documentation from 
Recording for the Blind, Inc., for people who have difficulty reading or handling printed documentation. 
This appendix also describes third-party hardware and software products that make personal computers 
easier to use by people with disabilities, and it lists organizations to contact for additional information. 

If you have access to the World Wide Web, you can learn more about using accessibility features that 
are included in Microsoft operating systems and other Microsoft products. 

 

Keys for moving and scrolling in a worksheet or 
workbook 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for moving and scrolling in a worksheet or workbook 

Keys for moving in a worksheet with End mode on 

Keys for moving in a worksheet with SCROLL LOCK on 

Keys for moving and scrolling in a worksheet or workbook 

Press To

Arrow keys Move one cell up, down, left, or right

CTRL+arrow key Move to the edge of the current data region

HOME Move to the beginning of the row
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Return to top 

Keys for moving in a worksheet with End mode on 

CTRL+HOME Move to the beginning of the worksheet

CTRL+END Move to the last cell on the worksheet, which is the cell at the 
intersection of the rightmost used column and the bottom-
most used row (in the lower-right corner), or the cell opposite 
the home cell, which is typically A1

PAGE DOWN Move down one screen

PAGE UP Move up one screen

ALT+PAGE DOWN Move one screen to the right

ALT+PAGE UP Move one screen to the left

CTRL+PAGE DOWN Move to the next sheet in the workbook

CTRL+PAGE UP Move to the previous sheet in the workbook

CTRL+F6 or CTRL+TAB Move to the next workbook or window

CTRL+SHIFT+F6 or 
CTRL+SHIFT+TAB

Move to the previous workbook or window

F6 Move to the next pane in a workbook that has been split

SHIFT+F6 Move to the previous pane in a workbook that has been split

CTRL+BACKSPACE Scroll to display the active cell

F5 Display the Go To dialog box

SHIFT+F5 Display the Find dialog box

SHIFT+F4 Repeat the last Find action (same as Find Next)

TAB Move between unlocked cells on a protected worksheet

Press To

END Turn End mode on or off

END, arrow key Move by one block of data within a row or column

END, HOME Move to the last cell on the worksheet, which is the cell at the 
intersection of the rightmost used column and the bottom-
most used row (in the lower-right corner), or the cell opposite 
the home cell, which is typically A1

END, ENTER Move to the last cell to the right in the current row that is not 
blank; unavailable if you have selected the Transition 
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Return to top 

Keys for moving in a worksheet with SCROLL LOCK on 

 
Return to top 

Tip   When you use scrolling keys (such as PAGE UP and PAGE DOWN) with SCROLL LOCK turned 
off, your selection moves the distance you scroll. If you want to preserve your selection while you scroll 
through the worksheet, turn on SCROLL LOCK first. 

 

Keys for previewing and printing a document 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

 
Work in print preview 

navigation keys check box on the Transition tab (Tools 
menu, Options command)

Press To

SCROLL LOCK Turn SCROLL LOCK on or off

HOME Move to the cell in the upper-left corner of the window

END Move to the cell in the lower-right corner of the window

UP ARROW or DOWN ARROW Scroll one row up or down

LEFT ARROW or RIGHT ARROW Scroll one column left or right

Press To

CTRL+P or CTRL+SHIFT+F12 Display the Print dialog box

Press To

Arrow keys Move around the page when zoomed in

PAGE UP or PAGE DOWN Move by one page when zoomed out

CTRL+UP ARROW or CTRL+LEFT ARROW Move to the first page when zoomed out

CTRL+DOWN ARROW or CTRL+RIGHT  
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Keys for working with worksheets, charts, and 
macros 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

 
 

Keys for entering data 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for entering data on a worksheet 

Keys for working in cells or the formula bar 

Keys for entering data on a worksheet 

ARROW Move to the last page when zoomed out

Press To

SHIFT+F11 or ALT+SHIFT+F1 Insert a new worksheet

F11 or ALT+F1 Create a chart that uses the current range

ALT+F8 Display the Macro dialog box

ALT+F11 Display the Visual Basic Editor

CTRL+F11 Insert a Microsoft Excel 4.0 macro sheet

CTRL+PAGE DOWN Move to the next sheet in the workbook

CTRL+PAGE UP Move to the previous sheet in the workbook

SHIFT+CTRL+PAGE DOWN Select the current and next sheet in the workbook

SHIFT+CTRL+PAGE UP Select the current and previous sheet in the workbook
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Return to top 

Keys for working in cells or the formula bar 

Press To

ENTER Complete a cell entry and move down in the selection

ALT+ENTER Start a new line in the same cell

CTRL+ENTER Fill the selected cell range with the current entry

SHIFT+ENTER Complete a cell entry and move up in the selection

TAB Complete a cell entry and move to the right in the selection

SHIFT+TAB Complete a cell entry and move to the left in the selection

ESC Cancel a cell entry

BACKSPACE Delete the character to the left of the insertion point, or 
delete the selection

DELETE Delete the character to the right of the insertion point, or 
delete the selection

CTRL+DELETE Delete text to the end of the line

Arrow keys Move one character up, down, left, or right

HOME Move to the beginning of the line

F4 or CTRL+Y Repeat the last action

SHIFT+F2 Edit a cell comment

CTRL+SHIFT+F3 Create names from row and column labels

CTRL+D Fill down

CTRL+R Fill to the right

CTRL+F3 Define a name

Press To

BACKSPACE Edit the active cell and then clear it, or delete the preceding 
character in the active cell as you edit cell contents

ENTER Complete a cell entry

CTRL+SHIFT+ENTER Enter a formula as an array formula

ESC Cancel an entry in the cell or formula bar

CTRL+A Display the Formula Palette after you type a function name 
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Return to top 

 

Keys for formatting data 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

in a formula

CTRL+SHIFT+A Insert the argument names and parentheses for a function 
after you type a function name in a formula

CTRL+K Insert a hyperlink

ENTER (in a cell with a hyperlink) Activate a hyperlink

F2 Edit the active cell and position the insertion point at the 
end of the line

F3 Paste a defined name into a formula

SHIFT+F3 Paste a function into a formula

F9 Calculate all sheets in all open workbooks

CTRL+ALT+F9 Calculate all sheets in the active workbook

SHIFT+F9 Calculate the active worksheet

= (equal sign) Start a formula

ALT+= (equal sign) Insert the AutoSum formula

CTRL+; (semicolon) Enter the date

CTRL+SHIFT+: (colon) Enter the time

CTRL+SHIFT+" (quotation mark) Copy the value from the cell above the active cell into the 
cell or the formula bar

CTRL+` (single left quotation mark) Alternate between displaying cell values and displaying cell 
formulas

CTRL+' (apostrophe) Copy a formula from the cell above the active cell into the 
cell or the formula bar

ALT+DOWN ARROW Display the AutoComplete list

Press To

ALT+' (apostrophe) Display the Style dialog box
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Keys for editing data 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for editing data 

CTRL+1 Display the Format Cells dialog box

CTRL+SHIFT+~ Apply the General number format

CTRL+SHIFT+$ Apply the Currency format with two decimal places (negative 
numbers appear in parentheses)

CTRL+SHIFT+% Apply the Percentage format with no decimal places

CTRL+SHIFT+^ Apply the Exponential number format with two decimal 
places

CTRL+SHIFT+# Apply the Date format with the day, month, and year

CTRL+SHIFT+@ Apply the Time format with the hour and minute, and indicate 
A.M. or P.M.

CTRL+SHIFT+! Apply the Number format with two decimal places, thousands 
separator, and minus sign (–) for negative values

CTRL+SHIFT+& Apply the outline border

CTRL+SHIFT+_ Remove outline borders

CTRL+B Apply or remove bold formatting

CTRL+I Apply or remove italic formatting

CTRL+U Apply or remove an underline

CTRL+5 Apply or remove strikethrough formatting

CTRL+9 Hide rows

CTRL+SHIFT+( (opening 
parenthesis)

 
Unhide rows

CTRL+0 (zero) Hide columns

CTRL+SHIFT+) (closing 
parenthesis)

 
Unhide columns
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Keys for inserting, deleting, and copying a selection 

Keys for moving within a selection 

Keys for editing data 

 
Return to top 

Keys for inserting, deleting, and copying a selection 

 
Return to top 

Press To

F2 Edit the active cell and put the insertion point at the end 
of the line

ESC Cancel an entry in the cell or formula bar

BACKSPACE Edit the active cell and then clear it, or delete the 
preceding character in the active cell as you edit the cell 
contents

F3 Paste a defined name into a formula

ENTER Complete a cell entry

CTRL+SHIFT+ENTER Enter a formula as an array formula

CTRL+A Display the Formula Palette after you type a function 
name in a formula

CTRL+SHIFT+A Insert the argument names and parentheses for a 
function, after you type a function name in a formula

F7 Display the Spelling dialog box

Press To

CTRL+C Copy the selection

CTRL+X Cut the selection

CTRL+V Paste the selection

DELETE Clear the contents of the selection

CTRL+HYPHEN Delete the selection

CTRL+Z Undo the last action

CTRL+SHIFT+PLUS SIGN Insert blank cells
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Keys for moving within a selection 

 
Return to top 

 

Keys for selecting data and cells 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for selecting cells, columns, or rows 

Keys for extending the selection with End mode on 

Keys for selecting cells that have special characteristics 

Keys for selecting cells, columns, or rows 

Press To

ENTER Move from top to bottom within the selection (down), or 
move in the direction that is selected on the Edit tab (Tools 
menu, Options command)

SHIFT+ENTER Move from bottom to top within the selection (up), or move 
opposite to the direction that is selected on the Edit tab (Tools 
menu, Options command)

TAB Move from left to right within the selection, or move down 
one cell if only one column is selected

SHIFT+TAB Move from right to left within the selection, or move up one 
cell if only one column is selected

CTRL+PERIOD Move clockwise to the next corner of the selection

CTRL+ALT+RIGHT ARROW Move to the right between nonadjacent selections

CTRL+ALT+LEFT ARROW Move to the left between nonadjacent selections

Press To

CTRL+SHIFT+* (asterisk) Select the current region around the active cell (the current 
region is a data area enclosed by blank rows and blank 
columns)
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Return to top 

Tip   When you use the scrolling keys (such as PAGE UP and PAGE DOWN) with SCROLL LOCK 
turned off, your selection moves the distance you scroll. If you want to keep the same selection as you 
scroll, turn on SCROLL LOCK first. 

Keys for extending the selection with End mode on 

SHIFT+arrow key Extend the selection by one cell

CTRL+SHIFT+arrow key Extend the selection to the last nonblank cell in the same 
column or row as the active cell

SHIFT+HOME Extend the selection to the beginning of the row

CTRL+SHIFT+HOME Extend the selection to the beginning of the worksheet

CTRL+SHIFT+END Extend the selection to the last used cell on the worksheet 
(lower-right corner)

CTRL+SPACEBAR Select the entire column

SHIFT+SPACEBAR Select the entire row

CTRL+A Select the entire worksheet

SHIFT+BACKSPACE Select only the active cell when multiple cells are selected

SHIFT+PAGE DOWN Extend the selection down one screen

SHIFT+PAGE UP Extend the selection up one screen

CTRL+SHIFT+SPACEBAR With an object selected, select all objects on a sheet

CTRL+6 Alternate between hiding objects, displaying objects, and 
displaying placeholders for objects

CTRL+7 Show or hide the Standard toolbar

F8 Turn on extending a selection by using the arrow keys

SHIFT+F8 Add another range of cells to the selection; or use the arrow 
keys to move to the start of the range you want to add, and 
then press F8 and the arrow keys to select the next range

SCROLL LOCK, SHIFT+HOME Extend the selection to the cell in the upper-left corner of the 
window

SCROLL LOCK, SHIFT+END Extend the selection to the cell in the lower-right corner of the 
window

Press To

END Turn End mode on or off
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Return to top 

Keys for selecting cells that have special characteristics 

 
Return to top 

END, SHIFT+arrow key Extend the selection to the last nonblank cell in the same 
column or row as the active cell

END, SHIFT+HOME Extend the selection to the last cell used on the worksheet 
(lower-right corner)

END, SHIFT+ENTER Extend the selection to the last cell in the current row. This 
keystroke is unavailable if you selected the Transition 
navigation keys check box on the Transition tab (Tools 
menu, Options command).

Press To

CTRL+SHIFT+* (asterisk) Select the current region around the active cell (the current 
region is a data area enclosed by blank rows and blank 
columns)

CTRL+/ Select the current array, which is the array that the active cell 
belongs to

CTRL+SHIFT+O (the letter O) Select all cells with comments

CTRL+\ Select cells in a row that don't match the value in the active 
cell in that row. You must select the row starting with the 
active cell.

CTRL+SHIFT+| Select cells in a column that don't match the value in the 
active cell in that column. You must select the column starting 
with the active cell.

CTRL+[ (opening bracket) Select only cells that are directly referred to by formulas in 
the selection

CTRL+SHIFT+{ (opening brace) Select all cells that are directly or indirectly referred to by 
formulas in the selection

CTRL+] (closing bracket) Select only cells with formulas that refer directly to the active 
cell

CTRL+SHIFT+} (closing brace) Select all cells with formulas that refer directly or indirectly to 
the active cell

ALT+; (semicolon) Select only visible cells in the current selection
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Keys for selecting charts and chart items 
Keys for selecting a chart sheet 

 
Keys for selecting an embedded chart 
Note   The Drawing toolbar must already be displayed.  

1. Press F10 to make the menu bar active. 
 

2. Press CTRL+TAB or CTRL+SHIFT+TAB to select the Drawing toolbar. 
 

3. Press the RIGHT ARROW key to select the Select Objects  button on the Drawing toolbar. 
 

4. Press CTRL+ENTER to select the first object. 
 

5. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until 
sizing handles appear on the embedded chart you want to select. 
 

6. Press CTRL+ENTER to make the chart active.  

Keys for selecting chart items 

 
There are also keys to use with PivotChart reports. 

 

Keys to use with databases and lists 

Press To

CTRL+PAGE DOWN Select the next sheet in the workbook, until the chart sheet 
you want is selected

CTRL+PAGE UP Select the previous sheet in the workbook, until the chart 
sheet you want is selected

Press To

DOWN ARROW Select the previous group of items

UP ARROW Select the next group of items

RIGHT ARROW Select the next item within the group

LEFT ARROW Select the previous item within the group
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Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for working with a data form 

Keys for using AutoFilter 

Keys for working with a data form 

 
Return to top 

Keys for using AutoFilter 

Press To

ALT+key, where key is the underlined 
letter in the field or command name

 
Select a field or a command button

DOWN ARROW Move to the same field in the next record

UP ARROW Move to the same field in the previous record

TAB Move to the next field you can edit in the record

SHIFT+TAB Move to the previous field you can edit in the record

ENTER Move to the first field in the next record

SHIFT+ENTER Move to the first field in the previous record

PAGE DOWN Move to the same field 10 records forward

CTRL+PAGE DOWN Move to a new record

PAGE UP Move to the same field 10 records back

CTRL+PAGE UP Move to the first record

HOME or END Move to the beginning or end of a field

SHIFT+END Extend a selection to the end of a field

SHIFT+HOME Extend a selection to the beginning of a field

LEFT ARROW or RIGHT ARROW Move one character left or right within a field

SHIFT+LEFT ARROW Select the character to the left

SHIFT+RIGHT ARROW Select the character to the right
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Return to top 

 

Keys for outlining data 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

 
 

Keys to use with PivotTable and PivotChart 
reports 

Press To

Arrow keys to select the cell that 
contains the column label, and then 
press ALT+DOWN ARROW

 
 
Display the AutoFilter list for the current column

DOWN ARROW Select the next item in the AutoFilter list

UP ARROW Select the previous item in the AutoFilter list

ALT+UP ARROW Close the AutoFilter list for the current column

HOME Select the first item (All) in the AutoFilter list

END Select the last item in the AutoFilter list

ENTER Filter the list by using the selected item in the AutoFilter 
list

Press To

ALT+SHIFT+RIGHT ARROW Group rows or columns

ALT+SHIFT+LEFT ARROW Ungroup rows or columns

CTRL+8 Display or hide outline symbols

CTRL+9 Hide selected rows

CTRL+SHIFT+( (opening parenthesis) Unhide selected rows

CTRL+0 (zero) Hide selected columns

CTRL+SHIFT+) (closing parenthesis) Unhide selected columns
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Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists: 

Keys for the PivotTable and PivotChart Wizard 

Keys for page fields in a PivotTable or PivotChart report 

Keys for laying out a PivotTable or PivotChart report 

Keys for grouping and ungrouping PivotTable items 

Keys for the PivotTable and PivotChart Wizard 

 
Return to top 

Keys for page fields in a PivotTable or PivotChart report 

Press To

UP ARROW or DOWN ARROW Select the previous or next field button in the list

LEFT ARROW or RIGHT ARROW Select the field button to the left or right in a multicolumn 
field button list

ALT+C Move the selected field into the Column area

ALT+D Move the selected field into the Data area

ALT+L Display the PivotTable Field dialog box

ALT+P Move the selected field into the Page area

ALT+R Move the selected field into the Row area

Press To

CTRL+SHIFT+* (asterisk) Select the entire PivotTable report

Arrow keys to select the cell that 
contains the field, and then 
ALT+DOWN ARROW

 
 
Display the list for the current field in a PivotTable report

Arrow keys to select the page field in a 
PivotChart report, and then 
ALT+DOWN ARROW

 
Display the list for the current page field in a PivotChart 
report

UP ARROW Select the previous item in the list
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Return to top 

Keys for laying out a PivotTable or PivotChart report 
1. Press F10 to make the menu bar active. 

 
2. Press CTRL+TAB or CTRL+SHIFT+TAB to select the PivotTable toolbar. 

 
3. Press the LEFT ARROW or RIGHT ARROW key to select the menu to the left or right or, when 

a submenu is visible, to switch between the main menu and submenu. 
 

4. Press ENTER (on a field button) and the DOWN ARROW and UP ARROW keys to select the 
area you want to move the selected field to.  

Note   To scroll to the top or bottom of the field list, press ENTER on the More Fields  or  
button. 

Return to top 

Keys for grouping and ungrouping PivotTable items 

 
Return to top  

 

Keys to use with the OLAP Cube Wizard 
Use these keys to complete Step 2 in the OLAP Cube Wizard. 

To move a field from the Source fields list to the Dimensions box 

DOWN ARROW Select the next item in the list

HOME Select the first visible item in the list

END Select the last visible item in the list

ENTER Display the selected item

SPACEBAR Select or clear a check box in the list

Press To

ALT+SHIFT+RIGHT ARROW Group selected PivotTable items

ALT+SHIFT+LEFT ARROW Ungroup selected PivotTable items
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1. Press the TAB key to select the Source fields list. 
 

2. Press the UP ARROW or DOWN ARROW key to select the field you want to move. 

Because you cannot change the order of a field after you move it, select first the field you want to 
appear at the top of the Dimensions box.  

3. Press the TAB key to select the > button, and then press ENTER. 
 

4. To move other fields, repeat steps 1 through 3.  

To move a field to a lower or higher level in the Dimensions box 
1. Press the TAB key to select the Dimensions box. 

 
2. Press the UP ARROW or DOWN ARROW key to select the field you want to move. 

 
3. Press CTRL+X. 

 
4. Press the UP ARROW or DOWN ARROW key to select where you want to move the field. 

 
5. Press CTRL+V.  

 

Keys for menus and toolbars 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

Press To

F10 or ALT Make the menu bar active, or close a visible menu and 
submenu at the same time

TAB or SHIFT+TAB (when a toolbar is 
active)

 
Select the next or previous button or menu on the toolbar

CTRL+TAB or CTRL+SHIFT+TAB 
(when a toolbar is active)

 
Select the next or previous toolbar

ENTER Open the selected menu, or perform the action assigned to 
the selected button

SHIFT+F10 Show a shortcut menu

ALT+SPACEBAR Show the program icon menu (on the program title bar)

DOWN ARROW or UP ARROW (with  
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Tip   You can select any menu command on the menu bar or on a visible toolbar with the keyboard. To 
select the menu bar, press ALT. (Then to select a toolbar, press CTRL+TAB repeatedly until you select 
the toolbar you want.) Press the underlined letter in the menu name that contains the command you 
want. In the menu that appears, press the underlined letter in the command name that you want. 

 

Keys for windows, dialog boxes, and edit boxes 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

This topic lists shortcut keys for: 

Keys for windows 

Keys for dialog boxes 

Keys for edit boxes in dialog boxes 

Keys for windows 

the menu or submenu displayed) Select the next or previous command on the menu or 
submenu

LEFT ARROW or RIGHT ARROW Select the menu to the left or right or, with a submenu 
visible, switch between the main menu and the submenu

HOME or END Select the first or last command on the menu or submenu

ESC Close the visible menu or, with a submenu visible, close 
the submenu only

CTRL+DOWN ARROW Display the full set of commands on a menu

In a window, press To

ALT+TAB Switch to the next program

ALT+SHIFT+TAB Switch to the previous program

CTRL+ESC Show the Windows Start menu

CTRL+W or CTRL+F4 Close the active workbook window

CTRL+F5 Restore the active workbook window size

F6 Move to the next pane in a workbook that has been split

SHIFT+F6 Move to the previous pane in a workbook that has been split

Page 21 of 30Keyboard shortcuts

2/22/2006file://C:\Documents and Settings\mo_luscre\Local Settings\Temp\~hh6D44.htm



 
Return to top 

Keys for dialog boxes 

CTRL+F6 Switch to the next workbook window

CTRL+SHIFT+F6 Switch to the previous workbook window 

CTRL+F7 Carry out the Move command (workbook icon menu, menu 
bar), or use the arrow keys to move the window

CTRL+F8 Carry out the Size command (workbook icon menu, menu 
bar), or use the arrow keys to size the window

CTRL+F9 Minimize the workbook window to an icon

CTRL+F10 Maximize or restore the workbook window

PRTSCR Copy the image of the screen to the Clipboard

ALT+PRINT SCREEN Copy the image of the active window to the Clipboard

In a dialog box, press To

TAB Move to the next option or option group

SHIFT+TAB Move to the previous option or option group

CTRL+TAB or CTRL+PAGE DOWN Switch to the next tab in a dialog box

CTRL+SHIFT+TAB or CTRL+PAGE 
UP

 
Switch to the previous tab in a dialog box

Arrow keys Move between options in the active drop-down list box or 
between some options in a group of options

SPACEBAR Perform the action assigned to the active button (the button 
with the dotted outline), or select or clear the active check 
box

Letter key for the first letter in the 
option name you want (when a drop-
down list box is selected)

 
 
 
Move to an option in a drop-down list box

ALT+letter, where letter is the key for 
the underlined letter in the option 
name

 
 
Select an option, or select or clear a check box

ALT+DOWN ARROW Open the selected drop-down list box

ENTER Perform the action assigned to the default command button 
in the dialog box (the button with the bold outline — often 
the OK button)
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Return to top 

Keys for edit boxes in dialog boxes 

 
Return to top 

 

Keys for working with the Open and Save As 
dialog boxes 
Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

ESC Cancel the command and close the dialog box

In an edit box, press To

HOME Move to the beginning of the entry

END Move to the end of the entry

LEFT ARROW or RIGHT ARROW Move one character to the left or right

CTRL+LEFT ARROW Move one word to the left

CTRL+RIGHT ARROW Move one word to the right

SHIFT+LEFT ARROW Select or unselect one character to the left

SHIFT+RIGHT ARROW Select or unselect one character to the right

CTRL+SHIFT+LEFT ARROW Select or unselect one word to the left

CTRL+SHIFT+RIGHT ARROW Select or unselect one word to the right

SHIFT+HOME Select from the insertion point to the beginning of the entry

SHIFT+END Select from the insertion point to the end of the entry

Press To

CTRL+F12 or CTRL+O Display the Open dialog box

ALT+F2 or F12 or CTRL+S Save the active workbook

ALT+SHIFT+F2 or SHIFT+F12 Display the Save as dialog box

ALT+1 Go to the previous folder ( )
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Keys for using the Office Assistant 

 
 

Keys for sending e-mail messages 
To use keys to send e-mail messages, you must configure Microsoft Outlook as your default e-mail 
program. If Outlook Express is your default e-mail program, you cannot use most of these keys to send 
e-mail messages. 

Note   To enlarge the Help window to fill the screen, press ALT+SPACEBAR and then press X. To 
restore the window to its previous size and location, press ALT+SPACEBAR and then press R. To print 
this topic, press ALT+O and then press P. 

ALT+2 Open the folder up one level from the open folder (Up One Level 
button )

ALT+3 Close the dialog box, and open your World Wide Web search 
page (Search the Web button )

ALT+4 Delete the selected folder or file (Delete button )

ALT+5 Create a new subfolder in the open folder (Create New Folder 
button )

ALT+6 Switch between List, Details, Properties, and Preview views

ALT+7 Show the Tools menu (Tools button)

Press To

F1 Get Help. Displays the Assistant balloon if the Assistant 
is turned on.

ALT+number (ALT+1 is the first topic, 
ALT+2 is the second, and so on)

 
Select a Help topic from the list the Assistant displays

ALT+DOWN ARROW See more Help topics

ALT+UP ARROW See previous Help topics

ESC Close an Assistant message or a tip

Press To

SHIFT+TAB Move to the e-mail message header. Cell A1 must be the active cell when you 
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Keys for working with drawing objects, 
AutoShapes, WordArt, and other objects 
Inserting drawing objects 
Insert an AutoShape 

Insert a text box 

Insert a WordArt object 

Selecting drawing objects 
Select a drawing object 

Editing drawing objects 
Rotate a drawing object 

Change the size of a drawing object 

Copy the attributes of a drawing object 

press these keys.

ALT+S Send the active spreadsheet as an e-mail message

CTRL+SHIFT+B Open the Address Book

ALT+K Check the names in the To, Cc, and Bcc boxes against the Address Book

ALT+PERIOD Open the Address Book in the To box

ALT+C Open the Address Book in the Cc box

ALT+B Open the Address Book in the Bcc box

ALT+J Go to the Subject box

ALT+P Open the Outlook Message Options dialog box (View menu, Options command 
in a message)

CTRL+SHIFT+G Create a message flag
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Insert an AutoShape by using the keyboard 
1. Press ALT+U to select the AutoShapes menu on the Drawing toolbar. 

 
2. Use the arrow keys to move to the category of AutoShapes you want, and then press the RIGHT 

ARROW key. 
 

3. Use the arrow keys to select the AutoShape you want. 
 

4. Press CTRL+ENTER.  

Note   To edit the AutoShape, select the AutoShape, and then use the keyboard to select AutoShape on 
the Format menu. Select the options you want on the available tabs. 

 

Insert a text box by using the keyboard 
1. Use the keyboard to select the Text Box  button on the Drawing toolbar. 

 
2. Press CTRL+ENTER. 

 
3. Type the text you want in the text box. 

 
4. When you finish typing and want to switch back to the worksheet, press ESC twice.  

Note   To format the text box (add a fill color or change the size, for example) select the text box, select 
Text Box on the Format menu, and then select the options you want on the available tabs. 

 

Insert a WordArt object by using the keyboard 
1. Use the keyboard to select WordArt (Insert menu, Picture submenu). 

 
2. Use the arrow keys to select the WordArt style you want, and then press ENTER. 

 
3. Type the text you want, and then use the TAB key to select other options in the dialog box. 

 
4. Press ENTER to insert the WordArt object.  

Note   To edit the WordArt object, select the object, select WordArt on the Format menu, and then 
select the options you want on the available tabs. 
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Select a drawing object by using the keyboard 
If your insertion point is on the worksheet, do the following:  

1. Press F10 to make the menu bar active. 
 

2. Press CTRL+TAB to select the Drawing toolbar. 
 

3. Press the RIGHT ARROW key to select the Select Objects  button on the Drawing toolbar. 
 

4. Press CTRL+ENTER to select the first drawing object. 
 

5. Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until 
sizing handles appear on the object you want to select.  

If your insertion point is within text in a drawing object, do the following:  

Press the TAB key to cycle forward (or SHIFT+TAB to cycle backward) through the objects until 
sizing handles appear on the object you want to select.  

Note   To switch from object selection mode back to working in cells, press ESC.  

 

Rotate a drawing object by using the keyboard 
1. Use the keyboard to select the drawing object you want to rotate. 

 
2. On the Format menu, select the command for the type of object selected — for example, 

AutoShape or Text Box — and then select the Size tab. 
 

3. In the Rotation box, enter the amount of rotation you want.  

 

Change the size of a drawing object by using the 
keyboard 

1. Use the keyboard to select the drawing object you want to resize. 
 

2. On the Format menu, select the command for the type of object selected — for example, 
AutoShape or Text Box — and then choose the Size tab. 

Select the options you want. For help on an option, select the option, and then press SHIFT+F1.  
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Copy the attributes of a drawing object by using 
the keyboard 

1. Use the keyboard to select the drawing object with the attributes you want to copy. 

If you select an AutoShape with attached text, the look and style of the text as well as the 
attributes of the AutoShape are copied.  

2. Press CTRL+SHIFT+C to copy the object attributes. 
 

3. Press TAB or SHIFT+TAB to select the object you want to copy the attributes to. 
 

4. Press CTRL+SHIFT+V to copy the attributes to the object.  

 

Lotus 1-2-3 keyboard equivalents 
Note   To enlarge the Help window to fill the screen, click Maximize on the Help title bar. To restore 
the window to its previous size and location, click Restore . To print this topic, click Print  on 
the Help toolbar. 

The default Microsoft Excel keyboard equivalents for Lotus 1-2-3 key commands are listed in the 
following table. 

Function key equivalents 

Lotus 1-2-3 Excel

F1 (Help) F1

F2 (Edit) F2

F3 (Name) F3

F4 (Absolute/relative) F4

F5 (Go to) F5

F6 (Next window) CTRL+F6

F7 (Query) Use the AutoFilter command (Tools menu) to find rows in a list: 

Press ALT, D, F, F to create an AutoFilter list. Select the cell that 
contains the column label, and then press ALT+DOWN ARROW to 
select a value in the AutoFilter list. 

F8 (Table) Tables recalculate automatically, unless you select the Automatic 
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Navigation keys 
Use the Excel keys unless you use transition navigation keys. 

 
 

Transition navigation keys for Lotus 1-2-3 
Note   To enlarge the Help window to fill the screen, click Maximize on the Help title bar. To restore 
the window to its previous size and location, click Restore . To print this topic, click Print  on 
the Help toolbar. 

You can change the navigation keys in Microsoft Excel to move around the worksheet the same way as 
in Lotus 1-2-3. If you select the Transition navigation keys check box on the Transition tab (Tools 
menu, Options command), the following keyboard shortcuts are in effect. 

Navigation keys 

except tables check box on the Calculation tab (Tools menu, 
Options command).

F9 (Calculate) F9

F10 (Graph) F11 or ALT+F1

Lotus 1-2-3 Excel

Up, Down UP ARROW, DOWN ARROW

Left, Right LEFT ARROW, RIGHT ARROW

End, Up CTRL+UP ARROW or END+UP ARROW

End, Down CTRL+DOWN ARROW or END+DOWN ARROW

End, Left CTRL+LEFT ARROW or END+LEFT ARROW

End, Right CTRL+RIGHT ARROW or END+RIGHT ARROW

Home CTRL+HOME

Tab CTRL+PAGE DOWN

Shift+Tab CTRL+PAGE UP

PgUp, PgDn PAGE UP or PAGE DOWN

Press To move
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Text-alignment prefix characters 
Use the following text-alignment prefix characters to assign alignment formats as you enter data in cells.

 
Note   When you enter cell references in formulas by selecting the cells, hidden columns are temporarily 
unhidden. 

SHIFT+TAB or CTRL+LEFT ARROW One screen to the left

TAB or CTRL+RIGHT ARROW One screen to the right

CTRL+PAGE DOWN To the next sheet in a workbook

CTRL+PAGE UP To the previous sheet in a workbook

HOME To the first cell on the sheet (the cell in the upper-left 
corner)

Press To

' (apostrophe) Left align data in the cell

" (quotation mark) Right align data in the cell

^ (caret) Center data within the cell

\ (backslash) Repeat characters across the cell
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